# Table Of Contents

- **What can I do with MultiSite Administration?** .......................................................... 1
- **What do you want to do?** ........................................................................................... 1
- **Additional Functionality** ............................................................................................. 3
- **What's New in this Release?** ....................................................................................... 4
- **Release 3.0 Enhancements** .......................................................................................... 6
- **Cutting through to a system** ........................................................................................ 8
- **Setting Up This Product** ............................................................................................ 9
- **Setting up MultiSite Administration** ......................................................................... 9
- **Configuring an MSA Server** ....................................................................................... 9
- **Assigning users to Systems** ....................................................................................... 10
- **Creating a custom privileges profile** .......................................................................... 11
- **Assigning a messaging system to a voice system** ..................................................... 12
- **Adding a UDP group** ................................................................................................ 12
- **Initializing voice systems** .......................................................................................... 13
- **Starting the queue** ...................................................................................................... 13
- **Understanding the Basics** ......................................................................................... 14
- **Logging into MultiSite Administration** .................................................................... 14
- **Understanding log files** ............................................................................................ 14
  - What is a log file? .......................................................................................................... 14
  - Types of log files .......................................................................................................... 14
  - How can I view a log file? ............................................................................................. 15
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding templates</td>
<td>15</td>
</tr>
<tr>
<td>Understanding the workspace</td>
<td>16</td>
</tr>
<tr>
<td>MSA Toolbars</td>
<td>17</td>
</tr>
<tr>
<td>Understanding the Browser Pane</td>
<td>18</td>
</tr>
<tr>
<td>Purpose</td>
<td>18</td>
</tr>
<tr>
<td>Access</td>
<td>18</td>
</tr>
<tr>
<td>Use</td>
<td>18</td>
</tr>
<tr>
<td>Understanding the MSA Manager</td>
<td>18</td>
</tr>
<tr>
<td>Purpose</td>
<td>18</td>
</tr>
<tr>
<td>Access</td>
<td>18</td>
</tr>
<tr>
<td>Understanding the Task tab</td>
<td>19</td>
</tr>
<tr>
<td>Purpose</td>
<td>19</td>
</tr>
<tr>
<td>Access</td>
<td>19</td>
</tr>
<tr>
<td>Use</td>
<td>19</td>
</tr>
<tr>
<td>Understanding the System Manager</td>
<td>19</td>
</tr>
<tr>
<td>Purpose</td>
<td>19</td>
</tr>
<tr>
<td>Access</td>
<td>19</td>
</tr>
<tr>
<td>Use</td>
<td>19</td>
</tr>
<tr>
<td>Understanding the Station Manager</td>
<td>20</td>
</tr>
<tr>
<td>Purpose</td>
<td>20</td>
</tr>
<tr>
<td>Access</td>
<td>20</td>
</tr>
<tr>
<td>Use</td>
<td>20</td>
</tr>
<tr>
<td>Understanding the Report Manager</td>
<td>20</td>
</tr>
<tr>
<td>Purpose</td>
<td>20</td>
</tr>
<tr>
<td>Access</td>
<td>20</td>
</tr>
<tr>
<td>Use</td>
<td>20</td>
</tr>
<tr>
<td>Understanding the Tree tab</td>
<td>21</td>
</tr>
<tr>
<td>Purpose</td>
<td>21</td>
</tr>
<tr>
<td>Access</td>
<td>21</td>
</tr>
<tr>
<td>Use</td>
<td>21</td>
</tr>
</tbody>
</table>
Administering Stations ................................................................................................................22

Applying templates ......................................................................................................................22

Copying templates .......................................................................................................................22

Deleting templates ........................................................................................................................23

Creating a new station .................................................................................................................24
   Option 1 ................................................................................................................................. 24
   Option 2 ................................................................................................................................ 24
   Option 3 .................................................................................................................................. 25
   Option 4 .................................................................................................................................. 25

Creating station templates ...........................................................................................................26
   Option 1: From anywhere in MultiSite Administration ............................................................. 26
   Option 2: If you are already creating or changing a station ....................................................... 27

Changing the data for a station .....................................................................................................27

Changing set types .......................................................................................................................29

Changing feature buttons ..........................................................................................................30
   Option 1 ................................................................................................................................ 30
   Option 2 ................................................................................................................................ 30
Polling manually for data ...............................................................56
Scheduling ..................................................................................57
Scheduling jobs ..........................................................................57
Changing the priority of a scheduled job .........................................57
Deleting a scheduled job ............................................................58
Removing an active job from the queue viewer ...............................58
Tasks for Super Users ..................................................................59
View server information ...............................................................59
Changing server information .......................................................59
Assigning users to Systems .........................................................60
Viewing information about MultiSite Administration users ................61
Changing information about MultiSite Administration users ...............62
Removing users from Systems ......................................................62
Creating a custom privileges profile .............................................63
Viewing a custom privileges profile ..............................................64
Changing a custom privileges profile ............................................65
Deleting a custom privileges profile ..............................................65
Disconnecting a user from MultiSite Administration .........................66
Changing system passwords .........................................................66
Changing passwords ..................................................................68
Changing a UDP group ...............................................................68
Removing a UDP group .............................................................68
Deleting destinations ..................................................................69
Option 1 ......................................................................................69
Option 2 ......................................................................................69
Reference ......................................................................................................................................71

MultiSite Administration menus ..................................................................................................71

MSA Manager menus ...................................................................................................................71
  File Menu 71
  View Menu 71
  Tools Menu 72
  Help Menu 72

System Manager menus ..............................................................................................................72
  File 72
  View 72
  Tools 73
  Messaging System 73
  Help 73

Station Manager menus ...............................................................................................................74
  File 74
  View 74
  Tools 74
  Messaging System 75
  Help 75

Report Manager menus................................................................................................................76
  File 76
  View 76
  Help 76

What is a destination? .................................................................................................................76

What is the queue? .......................................................................................................................77

Format requirements for imported files .....................................................................................77

What are list and display reports? ..............................................................................................78

Contacting Us ...............................................................................................................................79

Legal Information .......................................................................................................................79
  Disclaimer 79
  Warranty 79
  License 79
  Copyright 80
  Security and Virus Disclaimer 80
  Trademarks 81
General Contact Information ...........................................................................................................81
Contacting us for documentation .................................................................................................82
Contacting us about training ........................................................................................................82
Technical Support ........................................................................................................................83
Before you call .............................................................................................................................84
Giving us your feedback ................................................................................................................85
Index .............................................................................................................................................86
What can I do with MultiSite Administration?

Avaya MultiSite Administration lets you administer system-wide settings, administer phones, collect data and generate reports, in real time or by scheduling jobs to run when you want.

What do you want to do?

With MultiSite Administration, you can:

- Use MultiSite Administration’s System Manager to perform system-wide tasks like:
  - Specifying, viewing, changing, or deleting settings.
  - Printing button labels for your phones.
  - Making global changes.
  - Searching for objects by choosing from a list of canned queries.

- Use MultiSite Administration’s Station Manager to
  - Add, swap, move multiple stations, or delete stations.
  - Specify optional behavior for MultiSite Administration to perform when it removes a station.
  - Add or delete subscriber accounts on your messaging systems.
  - Change phone types or change feature buttons.
  - Create station templates and apply them to save time when creating new stations.
  - Move one or more stations from one voice system to another while maintaining the same extension.

- Use MultiSite Administration’s Report Manager to
  - View or change the DID dial plan.
  - Look up extensions.
Query the voice system for stations matching specific criteria.

- Run "list" reports or run "display" reports (What are they?).

- View collected reports.

- Choose from a list of canned reports.

- Schedule report generation.

- Specify delimiters for report output files.

- Set up keyboard shortcuts to run your most common reports.

- View log files.

- Use MultiSite Administration’s Data Manager to schedule data collection, view data files, view log information, or build a report template.

- Use MultiSite Administration’s toolbar to perform common tasks, like:
  - Cutting through to a voice system or messaging system.
  - Viewing the properties of the system you are currently administering.
  - Customizing the toolbar.
  - Viewing log files.
  - Viewing the schedule.

- Use MultiSite Administration’s menus to do all of the above.

- Specify what MultiSite Administration should do if it encounters errors while running a scheduled job.
Additional Functionality

- MultiSite Administration offers graphical phone illustrations in the station administration screens. You can assign features to phone buttons by clicking a button on the picture!

- MultiSite Administration validates the data you enter for extensions and ports, as well as ranges and field types before it sends data to a voice system.

- You can run jobs in real time or schedule them to occur later.

- If you schedule a job, when MultiSite Administration runs the job it performs detailed logging and if errors occurred MultiSite Administration will notify you when you enter the application.

- If your Communication Manager software lets you view an object, then MultiSite Administration also lets you view it, using "list" reports or "display" reports that are accessible from the MultiSite Administration Report Manager.
What's New in this Release?

Avaya MultiSite Administration Release 3.1 introduces the following enhancements.

Support for the following media servers

- S8400 server
- S8720 server

Support for the following media modules and boards

- G250-DCP media module
- G250-DS1 media module
- MM716 analog 16-port (12 station/line ports + 4 trunk ports) media module

Support for the following set types

- 4601+ IP Telephone
- 4602+ IP Telephone

Support for 996 Class of Restriction (CORs)

Support for the Customized Labels feature for the following set types

- 2410 Digital Telephone
- 2420 Digital Telephone
- 4610 IP Telephone
- 4620 IP Telephone
- 4621 IP Telephone
- 4622 IP Telephone
- 4625 IP Telephone
Support for the Display Feature Button Labels report

Support for the Maximum Time Agent in ACW before Logout (secs) field in the Agent Login ID object

New default field delimiter character for the Station Import wizard

HTAB (CTR-I) is the default field delimiter for external file format definition within the Station Import wizard.

Integration with Modular Messaging

- The ability to connect securely to a Modular Messaging system using LDAP over SSL
- The ability to pass the station "Name2" value to the Modular Messaging system when you add or change mailbox information

"Name2" is a secondary, alternative name field for certain Avaya Communication Manager objects that allows the input of a wide variety of Unicode, UTF-8 encoded character sets. "Name2" is also referred to as a "native language name" field.

Password "aging" and the ability to change your MSA password

Support for a vector object

- The ability to view, edit, and duplicate vectors
- The ability to set a system lock for vectors
- The ability to control access to the vector object using a System Manager Custom Privilege Definition
- New Quick Command support for changing a vector and duplicating a vector

The ability to display all System Manager object data in a table format

The merging of the Data Manager into the Report Manager

The "Database format using field/record delimiters" option on the List Reports dialog box is now in the Report Manager.

The ability to generate a report that lists all non-station object system locks

This report lists all non-station locks and the object type with an associated qualifier. You can generate this report from a button on the Non-Station Object Locks tab in the System Locks window under MSA Manager.

A recent command history for Quick commands

The Quick Command field will provide a drop-down list of the 25 most recently used commands. You may select entries from this list. MSA will maintain a history for each user that will persist across login sessions. The drop-down list will also provide a static list of common commands.
Support for file filters for file "save as" operations
MSA will support .rpt and *.* file filters when you perform a "save as" operation.

Port validation before a task is submitted
When you add a new station or change a set type, MSA will verify whether the port type is valid for that set type. This validation will occur when you submit the task as a process now, a process in background, or a scheduled task.

The ability to create a system lock on ports so you can reserve the ports for future use
You will use the Non-Station Object Locks tab in the System Locks window under MSA Manager to lock ports.

The ability to view all options for commands entered in the Quick Command field

The ability to copy the entire contents of abbreviated dial personal lists when you duplicate stations

Release 3.0 Enhancements
Avaya MultiSite Administration introduced the following enhancements in Release 3.0.

Support for the following media servers
- S8500B server
- S8710 server
- Blade server

Support for the following media modules and boards
- G250 virtual analog media module
- G250 BRI media module
- Crossfire board – TN2602AP IP media processor
- MM716 analog 16-port (12 line + 4 trunk) media module
- MM720B trunk/line side BRI 8-port media module
Support for New Set Types

- 2410 Digital Telephone
- 4601 IP Telephone
- 4621 IP Telephone
- 4622 IP Telephone
- 4625 IP Telephone
- H.323

Support for the Avaya SIP Business Phone

Support for the Large-Scale Meet-Me Conferencing feature

Support for Call Center Location Preference Distribution

Support for Call Center Options by Agent

Enhanced support for OPTIM/SCCAN

Embedded Native Communication Manager, which is a "cut-through" administration tool.

The Bulk Import wizard, which enables to import information for:

- Incoming Call Handling Treatment tables
- Public Unknown Numbering tables

The MultiLingual Name wizard
Cutting through to a system

Using the System CutThrough icon on the toolbar, you can open a Native Configuration Manager window and log into the voice system. When you cut through to a system, you will use an admin port on that system.

To cut through to a system, complete the following steps:

1. Click the **System CutThrough** icon on the toolbar.
   
   A message box appears.

2. Click **OK**.
   
   The Server Login dialog box appears. The voice system you want to log into is displayed in the title bar of the window.

3. Enter your login, and click **OK**.

4. Enter your password or ASG key response, and click **OK**.
   
   You are prompted to enter the terminal type.

   **NOTE:**
   
   The Cut Through window only supports the VT220 terminal type.

5. Enter **VT220** and press ENTER.
   
   The IP address and TCP port of the voice system to which you are connected are displayed at the bottom left of the window. The status of your session (for example, "online" or "offline") is displayed at the bottom right of the window.

While using the Cut Through window, status of your session (that is, whether you are logged into the system) is displayed at the bottom of the window. When you are logged into the system, the IP address of the voice system and the TCP port you are using are displayed.
Setting Up This Product

Setting up MultiSite Administration

MultiSite Administration was initially configured as part of the installation process, which is explained in detail in Avaya Integrated Management 3.1 MultiSite Administration Configuration, 555-233-137, which is available from the Integrated Management home page.

Configuring an MSA Server

This procedure describes how to configure a MultiSite Administration server. Only MultiSite Administration administrators (those with super-user permissions) can perform this activity.

To configure a MultiSite Administration server:

1. Click the MSA Manager tab in the Browser Pane.

2. Click MSA Server Configuration. The Avaya MultiSite Administration Server Configuration wizard dialog box appears.

3. Click Next.

4. (Optional) Complete the fields in this dialog box.

5. Click Next.

6. Specify whether you want to initialize voice systems manually or automatically. If you want MultiSite Administration to perform an initialization automatically as soon as it receives notification from the Integrated Management database (IMD) of new data for a voice system, click the Automatic Initialization option button. If you want to initialize the voice system manually, click the Manual Initialization option button. If you select this option button, you must use Task Scheduler or System Resources in MultiSite Administration to initialize the voice system.

7. (Optional) Specify the number of minutes after which inactive MultiSite Administration users should be disconnected automatically from the server.

8. Click Next. A summary of the MultiSite Administration server configuration appears.

9. Click Finish.
Assigning users to Systems

This procedures describes how to assign a user to a voice system registered in MultiSite Administration.

**NOTE:**
Before you can assign a user to a system, you must first add that user for MultiSite Administration in IMD.

To assign a user to a system:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.
   The MSA User Configuration screen appears. The Users on Systems tab displays all the user IDs for the MultiSite Administration server.

3. Click the **Users on Systems** tab.
   The Users on Systems tab displays all the user IDs for the MultiSite Administration server.

4. Click the ID of the user to whom you want to assign permission to a system.

5. Click **Assign User**.
   The Assign User dialog box appears.

6. Select the systems to which this user should have access. To select more than one system, hold down the Ctrl key and click on the appropriate systems.

7. In the User Roles area, select the "managers" to which this user should have access.
   The check boxes at the bottom of the dialog box represent the applications ("managers") within MultiSite Administration. Select only those you want this user to be able to access. If the user has Super User privileges, all of the check boxes are selected (including the Super User check box).
   If you select the System Manager check box, you must select the appropriate privilege for this user from the drop-down list box.

8. In the Additional Privileges area, select any additional privileges for this user.

9. Click **Assign**.
   A message box appears, indicating that the user was added to the selected system(s).

10. Click **OK**.
Creating a custom privileges profile

By default, all users you add to MultiSite Administration will have full privileges on the voice systems you specify. However, you can create and assign a custom privileges profile to a user. With a custom privileges profile, you can restrict users from accessing certain objects within the MultiSite Administration System Manager. For each object in the System Manager, you can select whether the user has no access, read-only access, or full access.

You can create up to 10 custom privileges profiles.

To create a custom privileges profile:

1. Click the MSA Manager tab in the Browser Pane.

2. Click MSA User Configuration.

3. Click the Define System Manager Custom Privilege tab.

4. Click Assign.
   The Add Custom Privilege dialog box appears.

5. In the Custom privilege name box, enter the name for the custom privilege profile you are creating.

6. For each Station Manager object, select the option button for the type of permission you want to assign.

7. If you want this user to be able to use Quick Commands, select the Use Quick Command check box.

8. If you want this user to have access to reports via the List/Display button, select the Full access to reports via List/Display button check box.

9. If you want this user to be able to access other user's jobs in the Translation Summary, select the Access other user's jobs in Translation Editor check box.

10. In the Notes box, enter any notes you want about this profile.

11. When finished, click Done.
   A message box appears, indicating that the addition was successful.

12. Click OK.
Assigning a messaging system to a voice system

This procedure describes how to add a messaging system to MultiSite Administration.

Only MultiSite Administration administrators (those with super-user permissions) can perform this activity.

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **Messaging System Configuration**. The Audix Nodes in MSA screen appears.

3. Select a messaging system where no IP address is listed, and then click **Assign**. The Assign Messaging System dialog box appears.

4. From the drop-down list box, select the voice system you want to associate with the messaging system.

5. Click **OK**.

6. Repeat Steps 3 through 5 for any other messaging systems you want to assign.

7. When finished, click **Done**.

Adding a UDP group

A UDP group is a set of voice systems that use the Uniform Dialing Plan (UDP) feature of Avaya’s Communication Manager Software.

To add a UDP group, complete the following steps:

1. Click the **MSA Manager tab** in the MultiSite Administration Browser Pane.

2. Click **UDP Configuration**.

3. Click **Add**.

   MultiSite Administration displays the Add UDP Group: UDP Configuration dialog box.

4. Complete the **Add UDP Group: UDP Configuration dialog box**.
Initializing voice systems

After you assign a messaging system to MultiSite Administration and start the queue for that system, you must perform the following steps to initialize the voice system:

1. From the MultiSite Administration main screen, click the MSA Manager tab. If you don’t see the MSA Manager tab, click here.

2. Click System Resources.

3. Click Initialize System.

4. Click Save Changes.

Starting the queue

The queue must be running before you can use MultiSite Administration to administer voice systems or messaging systems.

Any time you restart the MultiSite Administration server or upgrade to a new release of MultiSite Administration software, the queue will restart automatically.

If you ever stop the queue ‘manually,’ then you must perform the following steps to start the queue again:

1. From the MultiSite Administration main screen, click the MSA Manager tab. If you don’t see the MSA Manager tab, click here.

2. Click System Resources.

3. Click Start Queue.

4. Click Save Changes.
Understanding the Basics

Logging into MultiSite Administration

Before you can log into MultiSite Administration, you must have a login ID and password. The login ID and password were created by your MultiSite Administration Administrator (a super user) in Avaya Integrated Management Database (IMD). If you don't know your login and password, check with that person.

To log into MultiSite Administration, complete the following steps:

1. In the Name box, enter a login ID.
2. In the Password box, enter your password.
3. Click Login.

Understanding log files

What is a log file?

A log file is a history of the activities that have been submitted, through MultiSite Administration, to be processed on a voice system or messaging system. Log files may also contain messages from the MultiSite Administration application that you are currently 'in.'

All successful translations are logged as they are removed from the Translation Editor screen. If translations are scheduled for unattended processing, detailed logging occurs. If errors occurred, you will be automatically notified upon entry into the application.

A log file is not a history of all activities on the voice system. If someone cuts through to the voice system, for example, it is possible that changes would be made directly to the voice system and not go through MultiSite Administration. MultiSite Administration gets updated with all such changes.

Types of log files

There are two types of log files within MultiSite Administration:

- the master log file
- application log files

The master log file contains messages from all of the application log files. The application log files exist for the System Manager, Station Manager, Report Manager, and Data Manager applications.
How can I view a log file?

How you access the log file depends on which "manager" is currently active. In addition, in some of the "managers", it also depends if an application log file exists. In those "managers," an application log file will display if there is one, and the master log file will display if there is no application log file. In other "managers", it works differently.

You need to a) learn the pathway to the log file in each "manager" b) be able to recognize the appearance of an application log file versus the master log file.

Understanding templates

A template is a file that contains stored settings. You can use templates to streamline the process of performing various routine MultiSite Administration activities. Templates save the data that you enter, so you can perform similar activities later without re-entering the same data.

MultiSite Administration allows you to create, store, and use templates to simplify the tasks of adding stations, adding other objects, running reports, or exporting translations.

MultiSite Administration offers several 'prepackaged' templates, and you can create your own, as well.
Understanding the workspace

The MultiSite Administration screen displays different information depending on which icon you click in the Browser Pane on the left. Below is an example of one way the MultiSite Administration workspace may appear. Click an area in the image below to learn more about it. Optionally, you can access the same information from the Related Topics list, below.
MSA Toolbars

The toolbar displays icons for commonly performed tasks. The first six icons are dictated by MultiSite Administration. However, you can customize the icons to the right of these first six icons. The toolbar can contain a maximum of 20 icons.

- **Toolbar Customizer**: Clicking this icon allows you to customize the toolbar.
- **System Properties**: Clicking this icon allows you to view the "system properties" associated with the given voice system, including information like name, IP address, and so on.
- **System CutThrough**: Clicking this icon launches the Cut Through window, which is a terminal emulation window that enables you to log into the voice system.
- **View Logs**: Clicking this icon allows you to see a history of general activity on the MultiSite Administration server, and activity on the voice system that has been initiated by an MultiSite Administration user.
- **View Scheduled Entries**: Clicking this icon lets you view the reports and commands that are currently scheduled to occur on the given voice system.
- **Station Wizard**: Clicking this icon starts the Station Wizard, which allows you to perform various station administration tasks.
Understanding the Browser Pane

Purpose
The Browser Pane is essentially a graphical ‘menu’ that displays icons for the activities you perform most often. The Browser Pane contains the following tabs:

- The MSA Manager tab
- The Task tab
- The Tree tab

Access
The Browser Pane always appears on the left side of the MultiSite Administration main screen.

Use
1. Click a category to view the icons in that category.
2. Click an icon to begin an activity. When you do, MultiSite Administration displays the associated screen(s) in the right pane.
3. Select from the offered qualifiers or enter qualifiers in the text box that appears.

Understanding the MSA Manager

Purpose
The MSA Manager tab appears if you have administration privileges. The MSA Manager tab displays icons for activities that only MultiSite Administration administrators (super-users) can perform.

Access
In the Browser Pane, click the MSA Manager tab.
Understanding the Task tab

Purpose

The Task tab displays categories of activities that a day-to-day user of this product might perform.

Access

In the Browser Pane, click the Task tab.

Use

This tab presents the following categories.

- System Manager
- Station Manager
- Report Manager

Understanding the System Manager

Purpose

This category on the Task tab of the Browser Pane allows you to create and edit translations that affect your entire voice system, rather than a specific extension.

Access

In the Browser Pane, click the Task tab, and then click the System Manager category.

Use

Use the up and down arrow keys on the interface to scroll to the different icons.

Click an icon in the Browser Pane to display the associated screen in the right pane of the screen.

To learn about the screen that appears, see System Manager screen (generic).
Understanding the Station Manager

Purpose

This category on the Task tab of the Browser Pane allows you to create and manage stations using wizards.

NOTE:
You can also perform station administration activities by clicking the System Manager category, and then the Station icon.

Access

In the Browser Pane, click the Task tab, and then click the Station Manager category.

Use

Click an icon in the Browser Pane to display the associated dialog box in the right pane of the screen.

Understanding the Report Manager

Purpose

This category on the Task tab of the Browser Pane allows you to create and manage reports. This interface can get any report available and save or print it. Choose from a comprehensive list of custom reports that can be delimited and imported into other programs, or use them "as is". The reports module will analyze and summarize your voice system’s configuration and provide port and extension information needed to add a station.

Access

In the Browser Pane, click the Task tab, and then click the Report Manager category.

Use

Click an icon in the Browser Pane to display the associated dialog box in the right pane of the screen.
Understanding the Tree tab

Purpose
The Tree tab displays folders containing shortcuts to Communication Manager software commands and lets you execute those commands by double-clicking any given shortcut.

Access
In the Browser Pane, click the Tree tab.

Use
Double-click on the object called "Workspace" to display the objects inside.
Double-click objects to open or close them.
Administering Stations

Applying templates

This topic assumes that you know what a template is. By "applying" a template, we mean making the data that has been saved as a template become part of the activity that you are currently performing. Before you can apply a template, you must create a template. This topic assumes you have already created one.

Copying templates

Before you can copy a template, you must create a template. This topic assumes you have already created one.

To copy a template, complete the following steps:

1. In the MultiSite Administration Browser Pane, click the Task tab, and the appropriate icon for your activity. MultiSite Administration displays the appropriate ‘list’ screen for that icon.

2. From the Tools menu, choose View Template. If you do not see this menu, click here. MultiSite Administration displays a screen listing all public templates that have been saved in MultiSite Administration, and all private templates saved by you.

3. Click either the Public or Private tab.

4. Select the template you want to copy and click Copy.

5. Give the copy a name.

6. Click OK. MultiSite Administration saves the new template and adds it to the bottom of the list.
7. Do one of the following:

- To exit the screen, click **Cancel**.
- You can double-check that it is there by reopening the View Template list. It should appear in alphabetical order this time.
- To edit the highlighted template, click **OK**.
- Be sure the correct template was highlighted. MultiSite Administration does not automatically highlight the template that was most recently created.
- To delete the new template, highlight it from the list and click **Remove** and **OK**.

## Deleting templates

To delete a template, complete the following steps:

1. In the MultiSite Administration Browser Pane, click the **Task** tab, and the appropriate icon for your activity. MultiSite Administration displays the appropriate 'list' screen for that icon.

2. From the **Tools** menu, choose **View Template**. If you do not see this menu, click here. MultiSite Administration displays a screen listing all public templates that have been saved in MultiSite Administration, and all private templates saved by you.

3. Click either the **Public** or **Private** tab.

4. Select the template you want to delete and click **Remove**.

5. Click **OK**.
Creating a new station

There are several ways to create a new station using MultiSite Administration. Choose the option below that works best for you.

**Option 1**

1. Click the Task tab in the MultiSite Administration Browser Pane.
2. Click Station Manager.
3. Click Add New Station.
   MultiSite Administration displays the Add New Station wizard.
4. Complete the wizard.

As part of the process of completing the wizard, you can apply a station template (if you have created one). However, you can also create a station without using a template. If you do not apply a station template, Station Manager enters default field values, which you can change (for the given station) to suit your needs.

**Option 2**

Choose this option if you already know the extension number that you want to give to the new station.

1. Click the Task tab in the MultiSite Administration Browser Pane.
2. Click either Station Manager or System Manager.
3. In the "Quick Command" field (on the right side of the screen), type add station nnnn where nnnn is the extension number you are giving the new station.
4. In the confirmation dialog box, click OK.
5. Complete the Station Administration screen.
Option 3

Choose this option you prefer to view a list of existing stations before deciding what extension number to give to a new station.

1. Click the Task tab in the MultiSite Administration Browser Pane.

2. Click System Manager.

3. Click Station.
   MultiSite Administration displays a list of stations currently assigned on this voice system.

4. Click Add.

5. Specify the extension number of the station that you want to add and click OK.
   MultiSite Administration displays the Station Administration screen.

6. Complete the Station Administration screen

Option 4

Choose this option if you prefer that the voice system automatically assign the next available extension to the new station.

1. Click the Tree tab in the MultiSite Administration Browser Pane.

2. Double-click the folder called Station.

3. Click the entry called add station next.
   MultiSite Administration displays the Add dialog box.

4. Verify that the settings are correct and click OK.
   MultiSite Administration displays the Station Administration screen.

5. Complete the Station Administration screen as you normally would.
Creating station templates

This topic assumes that you know what a template is. By "station templates," we mean templates that you would use when creating a new station.

Station templates save all fields/features specified except extension, port, room, cable, jack, building, floor, and security code, which are unique for each station. There are multiple ways to create station templates. Choose the option (below) that works for you:

Option 1: From anywhere in MultiSite Administration

1. Click the Task tab in the MultiSite Administration Browser Pane.

2. Click Station Manager.

3. Click Add New Station Template.
   MultiSite Administration displays the Add New Station Template wizard.

4. From the Select Voice Terminal Set Type drop-down list, choose the type of phone for which you want to create a template.

5. Click Next.
   MultiSite Administration displays the Station Administration screen, showing a picture of the phone type that you selected.

6. Complete the Station Administration screen.

7. When finished, click Done.
   MultiSite Administration displays the Enter Template File Name dialog box.

8. Type a name for the template.
   MultiSite Administration will add a .tpl extension when it stores the template.

9. Select Private Template or Public Template.
   Private templates block general access to the template. Public templates can be used without your permission.

10. Click OK.
11. Perform one of the following steps:

- If you want to create more templates for this phone type, click **Yes**, and repeat Steps 6 through 10.

- If you do not want to create more templates for this phone type, click **No**.

You can see the new template entry when you [add a new station].

**Option 2: If you are already creating or changing a station**

This option works well if you are already creating or changing a station using the Station Administration screen. You can save the settings as a template as follows:

1. From the **Template** menu, choose **Save template**.

2. Type a name for the template. MultiSite Administration will add a .tpl extension when it stores the template.

3. Select **Private Template** or **Public Template**.
   - Private templates block general access to the template. Public templates can be used without your permission.

4. Click **OK**.

**Changing the data for a station**

To change the data for a station:

1. Click the **Task** tab in the MultiSite Administration Browser Pane.

2. Click **Station Manager**.

3. Click **Change Stations**.
   - The Change Stations dialog box appears.

4. Click **Change existing station data**, and then click **Next**.
   - The Extension dialog box appears.

5. Enter the extension of the station you want to change. Click Select to select the extension.

6. Click **Next**.
   - The Name/Native Name dialog box appears.
7. Make your changes.

8. When finished, click **Next**.
   The Set Type dialog box appears.

9. Make your changes.

10. When finished, click **Next**.
    The COR & COS dialog box appears.

11. Make your changes.

12. When finished, click **Next**.
    The Abbr Dialing & Buttons dialog box appears.

13. Make your changes.

14. When finished, click **Next**.
    The Site Information dialog box appears.

15. Make your changes.

16. When finished, click **Next**.
    The Optional Memberships dialog box appears.

17. Make your changes.

18. When finished, click **Next**.
    The Voice Mail dialog box appears.

19. Make your changes.

20. When finished, click **Next**.
    The Schedule dialog box appears.

21. Specify when to process the job and click **Next**.
    The Finish dialog box appears.

22. Click **Finished**.
Changing set types

To change the type of phone associated with a specific extension on your voice system, complete the following steps:

1. Click the Task tab in the MultiSite Administration Browser Pane.

2. Click Station Manager.

3. Click Change Stations.
   The Change Stations dialog box appears.

4. Click Change station voice terminal set types, and then click Next.
   The Extensions/Set Type dialog box appears.

5. Type the extensions to be changed. Click the Select button to select the extension(s).

6. Specify whether all or only some stations are changing set types:
   - If all stations are changing:
     1. Select All Exts To New Set Type.
     2. Select the new set type from the associated drop-down list box.
   - If only stations of a particular set type are changing:
     1. Select Only exts of specific set type.
     2. Select the old set type from the associated drop-down list box.
     3. Select the new set type from the To new voice terminal set type drop-down list box.

7. (Optional) Specify a template to use.

8. Click Next.
   The Schedule dialog box appears.

9. Specify when to process the job and click Next.
   The Finish dialog box appears.

10. Click Finished.
Changing feature buttons

There are multiple ways to perform this activity.

Option 1

1. Click the Task tab in the MultiSite Administration Browser Pane.
2. Click Station Manager.
3. Click Change Stations.
   The Change Stations dialog box appears.
4. Click Change station feature buttons, and then click Next.
   The Feature Buttons dialog box appears.
5. Specify the stations you want to change. Click the Select button to select the stations.
6. In the field called "Change ALL feature buttons of current value," enter the feature button that you want to change. Click Set Feature Button Value for a list of feature buttons.
   
   **Note:**
   Features are separated with commas.
7. In the field called "To new feature button value," enter the new feature button that you want to replace the old feature button. Click Set Feature Button Value for a list of feature buttons. Note: Features are separated with commas.
8. From the drop-down list box, specify whether the above change should be made to a specific set type only, or all set types (ALL).
9. Click Next.
   The Schedule dialog box appears.
10. Specify when to process the job and click Next.
   The Finish dialog box appears.
11. Click Finished.
   MultiSite Administration changes all feature buttons that meet the specified criteria. If a station listed does not exist or contain the button value, it will be skipped.

Option 2

1. Click the Task tab in the MultiSite Administration Browser Pane.
2. Click the System Manager category.
3. Click the Station icon.
   MultiSite Administration displays the appropriate System Manager screen.
4. In the list of stations, select the station you want to change and click Change.
5. Click **OK** to the confirmation dialog. MultiSite Administration displays the [Station Administration screen](#).

6. On the picture of the phone, click the button you want to assign a feature to.

7. In the screen that appears, pick the feature that you want to assign to the button.

8. Click **Assign**.

9. Repeat Steps 6 through 8 for each button you want to assign or change.

10. On the Station Administration screen, click **OK**.

11. Complete the "**Select**" screen.

---

**Changing Group Memberships**

Use this procedure to

- Add an extension to groups
- Remove an extension from groups

To change group membership associated with a specific extension on your voice system, complete the following steps:

1. Click the **Task** tab in the MultiSite Administration Browser Pane.

2. Click **Station Manager**.

3. Click **Change Stations**.
   
   The Change Stations dialog box appears.

4. Click **Change group memberships**, and then click **Next**.
   
   The Select Extension dialog box appears.

5. Type the extension to be changed. Click the **Select** button to select the extension.

6. Click **Next**.
   
   The Remove from Groups dialog box appears.
   
   The Ext currently belongs to list box displays the group to which the selected extension belongs.
7. If you want to remove this extension from a group, select that group in the Ext currently belongs to list box, and then click the > button. The selected group appears in the Remove from these memberships list box.

8. Repeat Step 7 if you want to remove this extension from another group.

9. When finished, click Next. The Add to Groups dialog box appears. The Group Types list box displays the groups to which you can add the selected extension.

10. If you want to add this extension to a group:
    1. Select that group in the Group Type box.
    2. Enter the appropriate number in the Number box.
    3. Click the > button. The selected group appears in the Station Memberships list box.

11. Repeat Step 10 if you want to add this extension to another group.

12. When finished, click Next. The Summary dialog box appears, showing the actions you selected.

13. Click Next. The Schedule dialog box appears.

14. Specify when to process the job and click Next. The Finish dialog box appears.

15. Click Finished.
Changing station extensions

This procedure enables you to perform the "change extension-station" command on multiple stations at one time.

To change station extensions:

1. Click the Task tab in the MultiSite Administration Browser Pane.
2. Click Station Manager.
3. Click Change Stations.
   The Change Stations dialog box appears.
4. Click Change station extensions, and then click Next.
   The Extension/Set Type dialog box appears.
5. In the Extension box, enter the extension of the station you want to change. Press Enter after entering data in each cell.
   Click View Current Exts to view a list of extensions that are currently assigned. After you enter an extension, click Get Current Values For Selected Ext From System to retrieve the current name, message lamp extension, and emergency location extension from the voice system.
6. In the New Extension box, enter the new extension number.
   Click View Available Extensions to view a list of extensions that are currently available.
7. Enter the new message lamp extension.
8. Enter the new emergency location extension.
9. If you want to change another extension, click New Row and repeat Steps 5 through 8 for each extension you want to change.
10. If you want these changes to be made on the associated messaging system, select the Change Associated Subscriber Mailboxes check box.
11. Click Next.
    The Schedule dialog box appears.
12. Specify when to process the job and click **Next**.
    The Finish dialog box appears.

13. Click **Finished**.

## Swapping stations

This procedure explains how to swap similar types of voice terminals; for example, digital for digital, analog for analog, or ISDN for ISDN.

To swap stations:

1. Click the **Task** tab in the MultiSite Administration Browser Pane.

2. Click **Station Manager**.

3. Click **Move Stations**.
   The Move Stations dialog box appears.

4. Click **Move an existing station by swapping it with another**, and then click **Next**.
   The Extensions dialog box appears.

5. Enter extensions to swap and information in the fields available.

6. At the bottom of the dialog box, check specific fields to swap.
   The ports are automatically swapped.

7. Click **Next**.
   The Site Data dialog box appears.

8. If you want to assign new values to any of the displayed settings, enter the appropriate information.
   If you do not enter a value in a field, the existing values on the voice system will be preserved.

9. When finished, click **Next**.
   The Schedule dialog box appears.

10. Specify when to process the job and click **Next**.
    The Finish dialog box appears.
11. Click **Finished**.

12. Remember to physically swap the phones.

### Moving multiple stations

To move multiple stations:

1. Click the **Task** tab in the MultiSite Administration Browser Pane.

2. Click **Station Manager**.

3. Click **Move Stations**.
   
The Move Stations dialog box appears.

4. Click **Move multiple stations to new location(s)/name(s)**, and then click **Next**.
   
The Select Station(s) dialog box appears.

5. Enter the extension of the station you want to move.
   
   Press Enter after entering data in each cell, press F2 to edit existing data. Click **View Current Exts** to view a list of extensions that you can highlight to populate this screen.

6. Enter the new port number.

7. Enter any other new information.
   
   If you do not enter a value in a field, the existing values on the voice system will be preserved.

8. Repeat Steps 5 through 7 for each station you want to move.
   
   Click **New Row** to create a new row.
   
   Enter information for each station, one station per line.

9. When finished, click **Next**.
   
   The Schedule dialog box appears.

10. Specify when to process the job and click **Next**.
    
    The Finish dialog box appears.

11. Click **Finished**.
Moving stations in the same ENP network

This procedure enables you to move one or more stations from one voice system to another while maintaining the same extension. The stations you move can be imported, obtained from a search, or entered manually.

**NOTE:**
The current voice system on which the stations reside and the destination voice system must be in the same UDP groups.

To move stations in the same ENP network:

1. Click the **Task** tab in the MultiSite Administration Browser Pane.
2. Click **Station Manager**.
3. Click **Move Stations**.
   The Move Stations dialog box appears.
4. Click **Move stations in the same ENP network**, and then click **Next**.
   MultiSite Administration displays the ENP Move Station wizard.
5. Complete the wizard.

Removing stations

To remove stations:

1. Click the **Task** tab in the MultiSite Administration Browser Pane.
2. Click **Station Manager**.
3. Click **Remove Stations**.
   The Remove Stations dialog box appears.
4. Specify the stations you want to remove.
   Either select from existing stations or enter the extensions. Separate extensions with commas. Type in ranges using a dash.
5. Click **Next**.
   The Messaging dialog box appears.
6. Perform one of the following steps:

- If you want to remove the station extension from its associated messaging system:
  1. Select Yes.
  2. Select the voice messaging system from the drop-down list box.

- If you do not want to remove the station extension from its associated messaging system, select No.

7. Click Next.
   The Schedule dialog box appears.

8. Specify when to process the job and click Next.
   The Finish dialog box appears.

9. Click Finished.
   The stations are automatically removed from any associated groups.

### Entering Native Names

Use this procedure to add or edit the name of a system object in native language. You can specify the native name for the following system objects:

- Hunt Group
- Invalid Number Dialed Display
- Restricted Number Dialed Display
- Station
- Trunk Group
- VDN

To enter the native name for a system object:

1. Click the Task tab.

2. Click System Manager or Station Manager.
3. From the Tools menu, select **MultiLingual Name Wizard**.
   The MultiLingual Name Wizard Voice System dialog box appears.

4. From the drop-down list box, select the appropriate system object.

5. Click the **Next** button.
   The MultiLingual Name Wizard System Object dialog box appears.

6. Perform one of the following steps:

   - If you selected **CPN/ANI/ICLID Replacement for Restricted Calls**:
     - If you want to add a new name, enter the name in the Name box.
     - If you want to modify the existing name, click the **Get Values From Switch** button, and then enter the name.

   - If you selected **CPN/ANI/ICLID Replacement for Unavailable Calls**:
     - If you want to add a new name, enter the name in the Name box.
     - If you want to modify the existing name, click the **Get Values From Switch** button, and then enter the new name.

   - If you selected **hunt-group**:
     - If you want to add the name for a new hunt group, click the **New Row** button, enter the name in the Group Name box, and then enter the native language name in the Native Name box.
     - If you want to add or change the name for an existing hunt group, click the **View Available Groups** button, and then enter the native language name in the Native Name box.

   - If you selected **invalid-number-dialed-display**:
     - If you want to add the name of a new object, enter the name in the Name box, and then enter the native language name in the Native Name box.
     - If you want to add or change the name for an existing object, click the **Get Values From Switch** button, and then enter the native language name in the Native Name box.
• If you selected **restricted-number-dialed-display:**
  
  - If you want to add the name of a new object, enter the name in the Name box, and then enter the native language name in the Native Name box.
  
  - If you want to add or change the name for an existing object, click the Get Values From Switch button, and then enter the native language name in the Native Name box.
  
• If you selected **station:**
  
  - If you want to add the name for a new station, click the New Row button, enter the name in the Name box, and then enter the native language name in the Native Name box.
  
  - If you want to add or change the name for an existing station, click the View Current Exts button, and then enter the native language name in the Native Name box.
  
• If you selected **trunk-group:**
  
  - If you want to add the name for a new trunk group, click the New Row button, enter the name in the Group Name box, and then enter the native language name in the Native Name box.
  
  - If you want to add or change the name for an existing trunk group, click the View Available Groups button, and then enter the native language name in the Native Name box.
  
• If you selected **vdn:**
  
  - If you want to add the name for a new VDN, click the New Row button, enter the name in the Name box, and then enter the native language name in the Native Name box.
  
  - If you want to add or change the name for an existing VDN, click the View Current Exts button, and then enter the native language name in the Native Name box.
  
7. Click the Finished button.
Using the Avaya Bulk Import Tool (ABIT)

The Avaya Bulk Import Tool (ABIT) enables you to edit station administration data via a user-friendly interface and prepare a formatted text file. You can then import this file into Avaya Communication Manager via MultiSite Administration. ABIT provides the platform for editing the station data that might use Avaya Eurofont/Optrex in Name1 or Native Name (Unicode). ABIT then converts Avaya Eurofont/Optrex or Native Name to the format required by Avaya Communication Manager.

With ABIT, you can directly enter Name1 and Name2 names associated with an extension. For Name1, ABIT uses Avaya Eurofont/Optrex. For Name2, ABIT uses Unicode.

Requirements

ABIT uses Microsoft Excel 2000 or later.

Getting ABIT

You can download ABIT from http:avaya.com/support.

Starting ABIT

To start ABIT, open the ABIT file. You must enable macros in order to use ABIT.

Importing Data

You can import a formatted text file into ABIT. During the import, you are prompted to enter:

- the place in ABIT where you want to put the data
- the import file name
- the delimiter

It is highly recommended that you perform a backup before you import the file. An import is irreversible. All existing data in ABIT is overwritten.

Editing Data

You may directly enter or change data in ABIT. ABIT will verify data accuracy in the extension, Name1, and Native Name. For example, an extension should be one to 10 digits in length. The Name1 and Name2 values must be less than 27 characters. ABIT checks the characters in a Name1 value to verify that those characters are in the Avaya Eurofont or Optrex (Kanafont) character set.

When using extended ASCII in a Name1 value, you may be unable to use all 27 characters because of data conversion. The Name2 value can include any characters supported by the Windows platform, but a user may not "mix" any two distinct writing scripts. (ASCII is excluded.) For example, you cannot include Hebrew and Japanese characters in a Name2 value.
Saving Station Data

After entering all the data in ABIT, you may save the file by clicking on the Save Station Data button. The Name1 and Name2 data are saved in the appropriate character sets. Because Name1 uses the Avaya Eurofont/Optrex character set, the Name1 data, together with the Name2 data, will not display properly in any other editor.
Administering Systems

Adding translations

MultiSite Administration offers many different ways to add translations to your voice system. This topic explains the general process. For information on performing a specific activity, refer to the Index and Find tabs within this online help system.

To add translations using MultiSite Administration, complete the following steps:

1. Click the **Task** tab.

2. Do one of the following:
   - To administer stations, click **Station Manager**.
   - To administer any other object on your voice system, click **System Manager**.

3. Do one of the following:
   - Click an appropriate icon in the MultiSite Administration Browser Pane.
   - Choose an option from the menu bar.
   - Type a command in the Quick Command box and click the **Submit** button.

4. Do one of the following:
   - Process now and wait for results.
   - Process in the background and log results later. With this option, a log file is created when translations process.
   - Schedule this translation to run in the future. If you select this, the Scheduler Selected Translations screen appears. You can set preferences for handling translations by choosing **File>Options**, which displays the **Options dialog box**.
   - Do not process.
   - Hold this translation in the **Translation Editor dialog box** for later editing / processing.
Creating object templates

This topic assumes that you know what a template is. By "object templates" we mean templates that store information about Communication Manager software objects other than stations. For instructions on creating station templates, see Creating station templates.

1. Click the Task tab in the MultiSite Administration Browser Pane.

2. Choose Tools>Create Template.
   If you do not see this menu, click here. MultiSite Administration displays the Create a Template screen.

3. From the "Select the object to create template for" drop-down list, pick the object you want to create a template for and click OK.
   MultiSite Administration displays one of many possible screens, depending on the object you picked in the previous step.

4. Complete the screen that appears and click OK.

5. Name the template file without an extension.

6. Select the category (private or public) for the template.
   Public will allow others to be able to use the template. Private allows only you to have access.

7. Click OK.

Importing translations

This feature lets you define and import a text (.txt) file or a .csv (comma-separated values) file.

To use this feature, complete the following steps:

1. Click the Task tab.

2. Click the System Manager.

3. Click an icon in the Browser Pane.

4. From the list screen that appears, click the Import button at the bottom of the screen. MultiSite Administration displays the Import screen for that object.

5. Complete the Import screen.
Importing data into the Incoming Call Handling Treatment tables

Use this procedure to import data in the comma-separated values (CSV) format from a file into Incoming Call Handling Treatment tables. The data from the file will populate the incoming call handling treatment information for a particular trunk.

For Incoming Call Handling Treatment tables, the trunk group number must be present on the first line of data. Each following line of data will correspond to one row in the Incoming Call Handling Treatment table. Each line of data should have the following format and order:

Service/Feature, Called Len, Called Number, Del, Insert, Per Call CPN/BN, Night Serv

For these files, each line of data is a record. The field delimiter is a comma (,), and the record delimiter is a CR/LF. For example, if the trunk group is 1, the first two lines (records) of a valid file in CSV format could be:

```
1 access,0,1234567890,2,21,on-only,attd
```

In this example:

- **1** is the trunk group number.
- **access** is the Service/Feature.
- **0** is the Called Len.
- **1234567890** is the Called Number.
- **2** is the Del.
- **21** is the Insert.
- **on-only** is the Per Call CPN/BN.
- **attd** is the Night Serv.

If you want to include comments in the file, start each comment line with a pound sign (#).

To import data into the Incoming Call Handling Treatment tables, complete the following steps:

1. Click the **Task** tab.

2. Click **System Manager** or **Station Manager**.

3. From the Tools menu, select **Bulk Import Wizard**.
   - The Bulk Import Wizard Select Object and Input File dialog box appears.

4. From the "Import Object" drop-down list box, select **inc-call-handling-trmt**.
5. Select the option button for the location of the file you want to import.
   - If the file you want to import is on your PC, select the **Import file from my PC** option button.
   - If the file you want to import is on the server, select the **Select file from the server** option button.

6. Click the **Browse** button.
   The File Upload dialog box appears.

7. Select the file you want to import, and then click the **Open** button.

8. Click the **Next** button.
   The Bulk Import Wizard Preview dialog box appears. The first five lines of the file you want to import are displayed.

9. If the lines appear correct to you, click the **Next** button.
   The Bulk Import Wizard Schedule dialog box appears.

10. Perform one of the following steps:
    - If you want to import the file now and wait for the results, select the **Run this translation now and wait for results** option button.
    - If you want MultiSite Administration to perform the import in the background and log the results, select the **Run this translation in the background and log results** option button.
    - If you want to schedule this import to be performed at a specified time, select the **Schedule this translation to run at the specified time** option button, click the **Schedule** button, and select a date and time.
    - If you want to save this import in the Translation Editor, select the **Save this translation in the translation editor** option button.

11. If you want to save this import as a private translation, select the **Private Translation** check box.
12. If you want to email the results of this import, select the Email results check box, and enter the email address of each person you want to receive these results. If you want to enter more than one email address, use a comma (,) or semi-colon (;) after each email address (for example, tjones@yourcompany.com;rsmith@yourcompany.com).

13. In the Notes box, enter any information you want about this import.

14. Click the Next button.

The Bulk Import Wizard Finish dialog box appears.

15. If you want MultiSite Administration to import the file, click the Finished button.

**Importing data into the Public Unknown Numbering table**

Use this procedure to import data in the comma-separated values (CSV) format into Public Unknown Numbering table.

Each line of data in the CSV format you import from a file into the Public Unknown Numbering table must have the following format and order:

Ext Len,Ext Code,Trk Grp,CPN Prefix,Total CPN Len

For these files, each line of data is a record. The field delimiter is a comma (,), and record delimiter is a CR/LF. For example, the first line (record) of a valid file in CSV format could be:

4,1234,8,567,7

In this example:

- **4** is the Ext Len.
- **1234** is the Ext Code.
- **8** is the Trk Grp.
- **567** is the CPN Prefix.
- **7** is the Total CPN Len.

If you want to include comments in the file, start each comment line with a pound sign (#).

To import data into the Public Unknown Numbering table, complete the following steps:

1. Click the Task tab.

2. Click System Manager or Station Manager.

3. From the Tools menu, select Bulk Import Wizard.

The Bulk Import Wizard Select Object and Input File dialog box appears.

4. From the "Import Object" drop-down list box, select public-unknown-numbering.
5. Select the option button for the location of the file you want to import.

   - If the file you want to import is on your PC, select the **Import file from my PC** option button.

   - If the file you want to import is on the server, select the **Select file from the server** option button.

6. Click the **Browse** button.
   
The File Upload dialog box appears.

7. Select the file you want to import, and then click the **Open** button.

8. Click the **Next** button.
   
The Bulk Import Wizard Preview dialog box appears. The first five lines of the file you want to import are displayed.

9. If the lines appear correct to you, click the **Next** button.
   
The Bulk Import Wizard Schedule dialog box appears.

10. Perform one of the following steps:

    - If you want to import the file now and wait for the results, select the **Run this translation now and wait for results** option button.

    - If you want MultiSite Administration to perform the import in the background and log the results, select the **Run this translation in the background and log results** option button.

    - If you want to schedule this import to be performed at a specified time, select the **Schedule this translation to run at the specified time** option button, click the **Schedule** button, and select a date and time.

    - If you want to save this import in the Translation Editor, select the **Save this translation in the translation editor** option button.

11. If you want to save this import as a private translation, select the **Private Translation** check box.
12. If you want to email the results of this import, select the **Email results** check box, and enter the email address of each person you want to receive these results. If you want to enter more than one email address, use a comma (,) or semi-colon (;) after each email address (for example, tjones@yourcompany.com;rsmith@yourcompany.com).

13. In the Notes box, enter any information you want about this import.

14. Click the **Next** button.
The Bulk Import Wizard Finish dialog box appears.

15. If you want MultiSite Administration to import the file, click the **Finished** button.

**Exporting translations**

By "exporting translations," we mean saving a copy of data into a text file in a format suitable for use with a third-party spreadsheet or database application. With MultiSite Administration, you can save a copy of the data that is generated by any Communication Manager software commands (as explained below).

To export translations, complete the following steps:

1. Click the **Task** tab.

2. Click **Data Manager**.

3. Click **List Reports**.
MultiSite Administration displays the List Reports dialog box.

4. In the **List Reports dialog box**, select **Database format** and click **Next**.
MultiSite Administration displays the Reports dialog box.

5. In the **Reports dialog box**, select the command-object that corresponds to the data you want to export, and click **Next**.

   If the object that you selected requires a qualifier, then specify the qualifier in the dialog box that appears. To learn more about any of these commands, see Chapter 19, "Command Reference," in the *Administrator’s Guide to Avaya Communication Manager Software*, 555-233-506.

   MultiSite Administration then displays the Template dialog box.

6. Complete the **Template dialog box**.
Duplicating translations

To duplicate translations, complete the following steps:

1. Click the Task tab.

2. Click System Manager.

3. Click the appropriate icon for the object you want to change. MultiSite Administration displays the appropriate System Manager screen.

4. Highlight the object you want to copy and click Duplicate at the bottom of the screen. MultiSite Administration displays the Duplicate dialog box for this object.

5. Complete the Duplicate dialog box and click OK. MultiSite Administration displays the appropriate "add" screen for this object. For example, if you are duplicating a station, it displays the Summary of Duplicates screen.

6. Change the screen as appropriate.

7. Click OK.

Changing translations

To change a translation, complete the following steps:

1. Click the Task tab.

2. Click System Manager.

3. Click the appropriate icon for the object you want to change. MultiSite Administration displays the appropriate System Manager screen.

4. Click Change at the bottom of the screen. MultiSite Administration displays the Change Station screen. When you need more information to administer the object (for example a station), click the List/Display button at the bottom of the screen to see the most current information.

5. Specify any necessary qualifier for the object you want to change. For example, if you are changing a station, specify which station you want to change. Click Select from current station data to select the station from an list.

6. Click OK. MultiSite Administration displays the Station Administration screen.
7. Change the Station Administration screen as appropriate.

8. Click **OK**.

### Changing translations globally

A "global change" is a change you make to all translations that meet specific criteria. For example, you might want to change all stations that currently have 2500 set types to 8406D sets. The Global Change feature will change field values across multiple valid objects. Not all fields presented are valid for all set types.

To change a set of translations globally, complete the following steps:

1. Click the **Task** tab.

2. Click **System Manager**.

3. Click the appropriate icon for the object you want to change.
   MultiSite Administration displays the appropriate **System Manager screen**.

4. Click **Change** at the bottom of the screen.
   MultiSite Administration displays the **Change Station screen**.

5. Click **Global Change**.
   MultiSite Administration displays the Global Change screen.

6. Complete the **Global Change screen**.
Removing translations

MultiSite Administration offers multiple ways to remove translations. If you are removing a station, see Removing Stations. To remove other types of objects from your voice system, complete the following steps:

1. Click the Task tab.
2. Click System Manager.
3. Click the appropriate icon for the object you want to remove.
   MultiSite Administration displays the appropriate System Manager screen.
4. Click Remove at the bottom of the screen.
   MultiSite Administration displays the appropriate Remove dialog box for the object you selected.
5. Complete the Remove dialog box.

Specifying options for removing translations

MultiSite Administration offers the following options for removing translations from a voice system:

- Remove Bridged Extensions
- Remove Extension from any Group

These options are enabled by default.

To disable these options, complete the following steps:

1. With the Task tab displayed in the MultiSite Administration Browser Pane, click the System Manager or Station Manager category.
2. Choose the File menu, and then Options.
3. Click the General tab.
4. In the area named “Remove station options,” adjust the settings to suit your needs.
5. Click OK.
# Entering Native Names

Use this procedure to add or edit the name of a system object in native language. You can specify the native name for the following system objects:

- Hunt Group
- Invalid Number Dialed Display
- Restricted Number Dialed Display
- Station
- Trunk Group
- VDN

To enter the native name for a system object:

1. Click the **Task** tab.

2. Click **System Manager** or **Station Manager**.

3. From the Tools menu, select **MultiLingual Name Wizard**. The MultiLingual Name Wizard Voice System dialog box appears.

4. From the drop-down list box, select the appropriate system object.

5. Click the **Next** button. The MultiLingual Name Wizard System Object dialog box appears.

6. Perform one of the following steps:

   - If you selected **CPN/ANI/ICCID Replacement for Restricted Calls**:
     - If you want to add a new name, enter the name in the Name box.
     - If you want to modify the existing name, click the **Get Values From Switch** button, and then enter the name.
• If you selected **CPN/ANI/ICLID Replacement for Unavailable Calls**:
  
  • If you want to add a new name, enter the name in the Name box.
  
  • If you want to modify the existing name, click the **Get Values From Switch** button, and then enter the new name.

• If you selected **hunt-group**:
  
  • If you want to add the name for a new hunt group, click the **New Row** button, enter the name in the Group Name box, and then enter the native language name in the Native Name box.
  
  • If you want to add or change the name for an existing hunt group, click the **View Available Groups** button, and then enter the native language name in the Native Name box.

• If you selected **invalid-number-dialed-display**:
  
  • If you want to add the name of a new object, enter the name in the Name box, and then enter the native language name in the Native Name box.
  
  • If you want to add or change the name for an existing object, click the **Get Values From Switch** button, and then enter the native language name in the Native Name box.

• If you selected **restricted-number-dialed-display**:
  
  • If you want to add the name of a new object, enter the name in the Name box, and then enter the native language name in the Native Name box.
  
  • If you want to add or change the name for an existing object, click the **Get Values From Switch** button, and then enter the native language name in the Native Name box.
• If you selected **station**:
  
  • If you want to add the name for a new station, click the **New Row** button, enter the name in the Name box, and then enter the native language name in the Native Name box.

  • If you want to add or change the name for an existing station, click the **View Current Exts** button, and then enter the native language name in the Native Name box.

• If you selected **trunk-group**:
  
  • If you want to add the name for a new trunk group, click the **New Row** button, enter the name in the Group Name box, and then enter the native language name in the Native Name box.

  • If you want to add or change the name for an existing trunk group, click the **View Available Groups** button, and then enter the native language name in the Native Name box.

• If you selected **vdn**:
  
  • If you want to add the name for a new VDN, click the **New Row** button, enter the name in the Name box, and then enter the native language name in the Native Name box.

  • If you want to add or change the name for an existing VDN, click the **View Current Exts** button, and then enter the native language name in the Native Name box.

7. Click the **Finished** button.
Monitoring the System and Running Reports

Creating report templates

This topic assumes that you know what a template is. To create a report template, complete the following steps:

1. Click the Task tab.
2. Click the Report Manager category.
3. Click the List Reports icon.
   MultiSite Administration displays the List Reports dialog box.
4. Select Customized template for presentation purposes.
   MultiSite Administration displays the Template dialog box.
5. Complete the tabs that appear, saving the Template tab for last.
6. When you are finished defining the template, click Save on the Template tab.
   MultiSite Administration displays the Save Template dialog box.
7. Complete the Save Template dialog box.

Specifying page size, source, orientation, and margins

You can specify the paper size, source, orientation, and layout by choosing File>Page Setup.
Polling manually for data

In a crunch, you can poll manually as described here. However, it is strongly recommended that you simply set up the Scheduler to do this for you.

It is possible to manually get the report from the voice system, name it and place it in the correct directory. This may be necessary if, for some reason, the Reports Manager could not poll the voice system and you want data.

To poll for data manually:

1. Connect to the voice system.
2. Click the Task tab.
3. Click Report Manager.
4. Click List Reports.
5. Click measurements trunk-group summary yesterday-peak.
6. Click OK.
7. To save the data, follow the instructions for downloading in Report output screen.
   The file name for polled reports is in a numerical format.
Scheduling

Scheduling jobs

By "scheduling jobs," we mean scheduling any activity that MultiSite Administration can perform for you in your absence. These activities include translations changes, collecting data from your voice system, generating reports from that data, and (for super-users only) performing MultiSite Administration ‘housekeeping’ activities.

Changing the priority of a scheduled job

If, after you schedule a job to run, you want to change the priority of the job, complete the following steps:

1. Open the View Processing Queue dialog box as follows:
   - If you have MultiSite Administration administrator privileges, click the MultiSite Administration Manager tab and choose Processing Queue from the View menu.
   - If you do NOT have MultiSite Administration administrator privileges, click the Task tab and choose one of the following:
     - Click System Manager and then choose Processing Queue from the View menu.
     - Click Station Manager and then choose Processing Queue from the View menu.

2. Select a queued job.

3. Click Priority. MultiSite Administration displays the Changing Job Priority screen.

4. Select a new priority number from the drop-down list.
   - 0 is lowest priority. 10 is highest priority.

5. Click Apply.
Deleting a scheduled job

If, after you schedule a job to run, you want to delete the job, complete the following steps:

1. From the System Manager or Station Manager, choose View Translations Summary from the Tools menu.
   The Current Translations Summary dialog box appears.
2. Select the scheduled job you want to delete.
3. Click Delete.

Removing an active job from the queue viewer

If you want to remove an active job from the queue viewer, complete the following steps:

1. Open the View Processing Queue dialog box as follows:
   - If you have MultiSite Administration administrator privileges, click the MSA Manager tab and choose Processing Queue from the View menu.
   - If you do NOT have MultiSite Administration administrator privileges, click the Task tab and choose one of the following:
     - Click System Manager and then choose Processing Queue from the View menu.
     - Click Station Manager and then choose Processing Queue from the View menu.
2. Select a queued job.
3. Click Cancel Job.
   MultiSite Administration displays a confirmation message.
4. Click Yes.
Tasks for Super Users

View server information

Only MultiSite Administration administrators (those with super-user permissions) can perform this activity.

To view server information in MultiSite Administration, complete the following steps:

1. Click the MSA Manager tab in the Browser Pane.
2. Click MSA Server Configuration. MultiSite Administration displays the Configuration wizard.
3. Click Next to move through the screens of the wizard.
4. Click Cancel.

Changing server information

After the MultiSite Administration server has been set up, you can change the information about the MultiSite Administration server using the MSA Server Configuration wizard. You might want to change this information if the physical location or the IP address of the MultiSite Administration server has changed.

Only MultiSite Administration administrators (those with super-user permissions) can perform this activity.

To view server information in MultiSite Administration, complete the following steps:

1. Click the MSA Manager tab in the Browser Pane.
2. Click MSA Server Configuration.

   MultiSite Administration displays the Configuration wizard.

3. Click Next to move through the screens of the wizard.
4. Change any appropriate information, clicking Next to move to each page.
5. Click Update.
Assigning users to Systems

This procedures describes how to assign a user to a voice system registered in MultiSite Administration.

NOTE:
Before you can assign a user to a system, you must first add that user for MultiSite Administration in IMD.

To assign a user to a system:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.
   The MSA User Configuration screen appears. The Users on Systems tab displays all the user IDs for the MultiSite Administration server.

3. Click the **Users on Systems** tab.
   The Users on Systems tab displays all the user IDs for the MultiSite Administration server.

4. Click the ID of the user to whom you want to assign permission to a system.

5. Click **Assign User**.
   The Assign User dialog box appears.

6. Select the systems to which this user should have access. To select more than one system, hold down the Ctrl key and click on the appropriate systems.

7. In the User Roles area, select the "managers" to which this user should have access.
   The check boxes at the bottom of the dialog box represent the applications ("managers") within MultiSite Administration. Select only those you want this user to be able to access. If the user has Super User privileges, all of the check boxes are selected (including the Super User check box).
   If you select the System Manager check box, you must select the appropriate privilege for this user from the drop-down list box.

8. In the Additional Privileges area, select any additional privileges for this user.
9. Click **Assign**.
   A message box appears, indicating that the user was added to the selected system(s).

10. Click **OK**.

**Viewing information about MultiSite Administration users**

To view information about a MultiSite Administration user:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.

3. Click the **Users on Systems** tab.

4. From the System Name box, select the appropriate system.
   The assigned users appear.

5. Select the user of interest.

6. Click **View Details**.
   MultiSite Administration displays the View User screen.

7. When you are finished viewing the user information, click **Cancel**.
Changing information about MultiSite Administration users

To change information about MultiSite Administration users:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.

3. Click the **Users on Systems** tab.

4. From the System Name box, select the appropriate system.
   The assigned users appear.

5. Select the user of interest.

6. Click **Update User**.
   MultiSite Administration displays the Update User screen.

7. Make any necessary changes.

8. When you are finished changing the user information, click **Save**.

Removing users from Systems

This procedure describes how to remove a user from a voice system registered in MultiSite Administration. When you remove a user, that user will be denied access to that voice system.

To remove a user from a system:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.
   The MSA User Configuration screen appears.

3. Click the **Users on Systems** tab.
   The Users on Systems tab displays all of the user IDs for the MultiSite Administration server.
4. From the System Name box, select the system from which you want to remove the user. The user IDs for the selected system are displayed.

5. Click the ID of the user you want to remove from the system.

6. Click **Remove User**.
   The Remove User dialog box appears. The system you selected is highlighted.

7. If you want to remove this user from other systems, hold down the Ctrl key and click on the appropriate systems.

8. Click **Remove**.
   A message box appears, indicating that the user was added to the selected system(s).

9. Click **OK**.

### Creating a custom privileges profile

By default, all users you add to MultiSite Administration will have full privileges on the voice systems you specify. However, you can create and assign a custom privileges profile to a user. With a custom privileges profile, you can restrict users from accessing certain objects within the MultiSite Administration System Manager. For each object in the System Manager, you can select whether the user has no access, read-only access, or full access.

You can create up to 10 custom privileges profiles.

To create a custom privileges profile:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.

3. Click the **Define System Manager Custom Privilege** tab.

4. Click **Assign**.
   The Add Custom Privilege dialog box appears.

5. In the Custom privilege name box, enter the name for the custom privilege profile you are creating.

6. For each Station Manager object, select the option button for the type of permission you want to assign.
7. If you want this user to be able to use Quick Commands, select the **Use Quick Command** check box.

8. If you want this user to have access to reports via the List/Display button, select the **Full access to reports via List/Display button** check box.

9. If you want this user to be able to access other user’s jobs in the Translation Summary, select the **Access other user’s jobs in Translation Editor** check box.

10. In the Notes box, enter any notes you want about this profile.

11. When finished, click **Done**.

   A message box appears, indicating that the addition was successful.

12. Click **OK**.

### Viewing a custom privileges profile

To view a custom privileges profile:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.

3. Click the **Define System Manager Custom Privilege** tab.

4. Select the custom privileges profile you want to view.

5. Click **View Details**.

   The View Custom Privilege dialog box appears.

6. When finished, click **Cancel**.
Changing a custom privileges profile

To change a custom privileges profile:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.

3. Click the **Define System Manager Custom Privilege** tab.

4. Select the custom privileges profile you want to change.

5. Click **Update**.  
   The Update Custom Privilege dialog box appears.

6. Make your changes.

7. When finished, click **Done**.

Deleting a custom privileges profile

Use this procedure to delete a custom privileges profile.

To delete a custom privileges profile:

1. Click the **MSA Manager** tab in the Browser Pane.

2. Click **MSA User Configuration**.

3. Click the **Define System Manager Custom Privilege** tab.

4. Select the custom privileges profile you want to delete.

5. Click **Remove**.  
   The Delete Custom Privilege dialog box appears.

6. Click **Delete**.
Disconnecting a user from MultiSite Administration

Only MultiSite Administration administrators (those with super-user permissions) can perform this activity.

To disconnect a user from MultiSite Administration:

1. Click the MSA Manager tab in the Browser Pane.
2. Choose View>Who’s Logged On.
   MultiSite Administration displays the Who’s Logged On screen. You can set the screen refresh rate from 1 to 60 seconds.
3. Select the user you want to disconnect.
4. Click Disconnect User From System.
   The disconnected user will see a message indicating a "kill" by the administrator.

Changing system passwords

This procedure enables you to change the password of a login that exists on multiple voice systems.

NOTE:
Only "super-users" can perform this procedure.

To change the password of a voice system login:

1. Click the Task tab in the MultiSite Administration Browser Pane.
2. Click System Manager or Station Manager.
3. From the Tools menu, select Change System Password.
   The Change System Password wizard dialog box appears.
4. Select the appropriate voice systems.
   - To select multiple voice systems, press and hold the Ctrl key, and click on the appropriate voice system.
   - To select all of the voice systems, click the Select All check box.
5. If you want to view the logins on the selected voice systems, click **Login info**. The Logins dialog box appears and displays the service level and status for each login on the selected voice system. When finished, click **Done**.

6. Click **Next**. The next Change System Password wizard dialog box appears.

7. If you want to change the password of a login ID that is shared by the selected voice systems, enter that login ID in the Common login box.

8. Perform one of the following steps:
   
   - If you want to use passwords, click the **Use Passwords** check box, and then enter the new password for the common login in the Common password box.
   
   - If you want to use ASG key, click the **Use ASG Key** check box, and then click **Make ASG Key** to generate the ASG key for the common login. The generated ASG key appears in the Common ASG key box.

9. Click **Next**. The next Change System Password wizard dialog box appears.

10. Perform one of the following steps:

    - If you want to use passwords, enter the new password in the Password box.

    - If you want to use ASG key, click **Make ASG Key** to generate the ASG key for the selected voice system. The generated ASG key appears in the ASG key box.

11. Click **Next**. The next Change System Password wizard dialog box appears.

12. If you want to modify the settings, click **Back**.

13. To complete this procedure, click **Finish**.
Changing passwords

All MultiSite Administration passwords are maintained in the Avaya Integrated Management Database (IMD). You can change your MSA password from the MSA Login dialog box.

Changing a UDP group

To change a UDP group:

1. Click the MultiSite Administration Manager tab in the MultiSite Administration Browser Pane.
2. Click UDP Configuration.
3. Select the group you want to modify and click Update. MultiSite Administration displays the Update UDP Configuration screen.
4. Make any necessary changes.
5. Click Ok. Changes are automatically applied to the group.

Removing a UDP group

To remove a UDP group:

1. Click the MultiSite Administration Manager tab in the MultiSite Administration Browser Pane.
2. Click UDP Configuration.
3. Select the UDP group you want to remove.
4. Click Delete. MultiSite Administration displays a confirmation screen.
5. Click Yes.
Deleting destinations

This topic assumes that you know what a destination is. There are multiple ways to delete a destination.

Option 1

If you are not a super-user, then you can delete only destinations that were created by you. You cannot delete the private destinations of other MultiSite Administration users. This option explains how to access the Destination Manager screen via the Data Manager or Report Manager.

1. Click the Task tab.
2. Click Data Manager or Report Manager.
3. From the Schedule menu, choose Schedule or Scheduler. MultiSite Administration displays the Scheduled Entries dialog box.
4. Click Add Entry. MultiSite Administration displays the Schedule New Entry dialog box.
5. Click the Reports tab.
6. Click FTP Dest. File. MultiSite Administration displays the Destination Manager dialog box.
7. Make sure the Private tab is selected.
8. Select the destination that you want to delete and click Delete.
9. Click Yes.

Option 2

This option explains how to access the Destination Manager screen via the System Manager.

1. Click the Task tab.
2. Click System Manager.
3. Click any icon in the System Manager, enter a qualifier if appropriate, and click OK. MultiSite Administration displays a screen with information about that object.
5. Enter a qualifier if appropriate and click **List**.  
MultiSite Administration displays the View Processing Queue dialog box (if there is a queue), or displays the results of your "list" command in a report output screen.

6. Click **FTP**.  
MultiSite Administration displays the **FTP Screen (dialog box)**.

7. Click **FTP Dest. File**.  
MultiSite Administration displays the Destination Manager dialog box.

8. Make sure the **Private** tab is selected.

9. Select the destination that you want to delete and click **Delete**.

10. Click **Yes**.
Reference

MultiSite Administration menus

The menus that MultiSite Administration displays depend on what has been selected in the Browser Pane. To learn about the menus currently on your screen, select which of the following categories is currently displayed in your Browser Pane:

- **MSA Manager**
- **System Manager**
- **Station Manager**
- **Report Manager**

**MSA Manager menus**

If the **MSA Manager tab** is displayed in the Browser Pane, then the main screen should be displaying the following menus. ([Click here](#) if it is not.) Click a menu below to learn about the screen that appears when you choose that option.

**File Menu**

- Change Voice System: lets you access other voice systems if they have been added to MultiSite Administration
- Page Setup: displays the standard print dialog box that your operating system uses.
- Exit: closes the MultiSite Administration client application.

**View Menu**

- **Logs**
- **Processing Queue**
- **Properties**
- **Scheduled Entries**

- System Status: shows the status of every queue for every voice system and what command is running on that queue

- Who’s Logged On: shows a list of people that are currently logged into the given MultiSite Administration server
Tools Menu

**Toolbar Customizer**

**Message Broadcaster**

Help Menu

Monitor:

Trace: Gathers information about background processes

Help Topics: Launches the online help system

About: Displays the release number and release date of the software

### System Manager menus

If the **System Manager** category is displayed in the Browser Pane, then the main screen should be displaying the following menus. ([Click here](#) if it is not.)

**File**

Change Voice System: lets you access other voice systems if they have been added to MultiSite Administration

**Options**

Page Setup: displays the standard print dialog box that your operating system uses.

Exit: closes the MultiSite Administration client.

**View**

Log: displays the log of Station Manager activities for this voice system.

**Processing Queue**

**Properties**

**Scheduled Entries**

Server Time/Date: displays the time that is currently set on the server.

Available Analog Ports

Available BRI Ports

Available Digital 2-wire Ports

Available Digital 4-wire Ports

Available Hybrid Ports

Available Ports Summary
Tools

**Button Labels**

Cut-Thru Emulation: Launches Avaya Native Configuration Manager, which you can use to access a voice system using terminal emulation.

**Diagnostics**

**DID Dialplan**

**Find**

**Translation Editor**

**UDP Updates**

**Create Template**

**View/Edit Template**

Bulk Import Wizard: Enables you to import data into the **Incoming Call Handling tables** and the **Public Unknown Numbering tables**.

**Change System Password**

**MultiLingual Name Wizard**

Messaging System

**Setup**

**Add Subscriber**

**Change Subscriber**

**Remove Subscriber**

Display Reports: Enables you to select the display report you want to view for the AUDIX voice messaging system.

List Reports: Enables you to select the list report you want to view for the AUDIX voice messaging system.

**Unprocessed Automatic Subscriber Updates**

Help

**Monitor**

**Performance**

Trace: Gathers information about background processes

**Help Topics**: Launches the online help system

**About**: Displays the release number and release date of the software
Station Manager menus

If the Station Manager category is displayed in the Browser Pane, then the main screen should be displaying the following menus.

File

Change Voice System: lets you access other voice systems if they have been added to MultiSite Administration.

Options

Page Setup: displays the standard print dialog box that your operating system uses.

Exit: closes the MultiSite Administration client

View

Log: displays the log of Station Manager activities for this voice system.

Processing Queue

Properties

Scheduled Entries

Server Time/Date: displays the time that is currently set on the server.

Available Analog Ports

Available BRI Ports

Available Digital 2-wire Ports

Available Digital 4-wire Ports

Available Hybrid Ports

Available Ports Summary

Tools

Button Labels

Cut-Thru Emulation: Launches Avaya Native Configuration Manager, which you can use to access a voice system using terminal emulation.

Diagnostics

DID Dialplan

Find

Translation Editor

UDP Updates
Create Template

View/Edit Template

Bulk Import Wizard: Enables you to import data into the Incoming Call Handling tables and the Public Unknown Numbering tables.

Change System Password

MultiLingual Name Wizard

Messaging System

Setup

Add Subscriber

Change Subscriber

Remove Subscriber

Display Reports: Enables you to select the display report you want to view for the AUDIX voice messaging system.

List Reports: Enables you to select the list report you want to view for the AUDIX voice messaging system.

Unprocessed Automatic Subscriber Updates

Help

Monitor:

Trace: Gathers information about background processes

Help Topics: Launches the online help system

About: Displays the release number and release date of the software
Report Manager menus

If the Report Manager category is displayed in the Browser Pane when you view the main screen, then the main screen is displaying the following menus.

File

Change Voice System: lets you access other voice systems if they have been added to MultiSite Administration.
Page Setup: displays the standard print dialog box that your operating system uses.
Exit: closes the MultiSite Administration client application.

View

Log

Help

Monitor

Trace: Gathers information about background processes
Help Topics: Launches the online help system
About: Displays the release number and release date of the software

What is a destination?

A destination is a location on a computer where you want to put files or get files. MultiSite Administration cannot put or get files from a computer without basic information, such as:

- The IP address of the computer
- A login ID and password to gain access to the computer
- The full pathname to the directory

You can provide this type of information to MultiSite Administration using the Destination Editor. MultiSite Administration also lets you specify whether to allow other MultiSite Administration users access to this destination. Simply indicate whether the destination is public or private when you create it (or afterwards).
What is the queue?

Normally, there are a limited number of logins to a voice system or messaging system. To conserve logins, MultiSite Administration needs only one login to a voice system or messaging system, and uses a queue to collect, prioritize, and send jobs from multiple concurrent MultiSite Administration users. MultiSite Administration uses separate queues for each voice system that has been added to MultiSite Administration.

Each job is placed in the queue by level of importance and when it was received. The queue uses as many ports as were set up in the System Resources screen to send jobs to the voice system.

Format requirements for imported files

If you are importing a file to add or change objects, the input file must adhere to the following requirements:

- the records must be in the exact order that you specify in the Define External File Format dialog box.
- lines beginning with # are treated as comments
- one record per line
- record delimiter is CR/LF

You can create the import file using third party applications, like spreadsheet programs, database management systems, or text editors.

For removing objects (i.e., stations), the records should consist only of the qualifiers (extensions, group#).
What are list and display reports?

MultiSite Administration’s "list" reports are the reports that the Communication Manager software on your voice system generates if you were to cut through to the system and type the Communication Manager software command list <object>.

MultiSite Administration’s "display" reports are the reports that appear if you were to type the command display <object>.

The difference between the list command and the display command is that typically the list command displays a list of a specific type of object (for example, list station displays a list of the stations on your system), whereas the display command is used to view information about a specific object (for example, display station 10001 displays information specific to that station only).

Since you may want to view a list of objects or a information about a specific object, MultiSite Administration offers both types of reports. When you click List Reports or Display Reports in the MultiSite Administration Report Manager, the dialog boxes that appear look very nearly identical. The difference is in the qualifier that you specify after you choose the object you want to view. For 'list' reports, the qualifier is some type of range. For 'display' reports, the qualifier identifies a specific instance of that object.
Contacting Us

Legal Information

This document contains information related to the Avaya Network Management Enterprise Server Software (as defined below) and Documentation ("Product"). "Documentation" means this document and Avaya's information manuals in printed or electronic form containing operating instructions and performance specifications that Avaya or its suppliers generally make available to users of its products, and which Avaya delivers to End User with the Products. "End User" means any customer of Avaya or its authorized resellers, or any end user of the Product. See the Software and Documentation DVD/CD inserts for additional legal and licensing information.

Changes and corrections to the information in this document may be incorporated in future releases.

Disclaimer

Avaya, its affiliates or subsidiaries ("Avaya") are not responsible for any modifications, additions or deletions to the original published version of the Documentation unless such modifications, additions or deletions were performed by Avaya. End User agrees to indemnify and hold harmless Avaya, Avaya’s agents, servants, directors, officers, and employees against all claims, lawsuits, demands and judgments arising out of, or in connection with, subsequent modifications, additions or deletions to the Documentation to the extent made by the End User.

Warranty

Avaya provides a limited warranty on the Product. Refer to your customer sales agreement to establish the terms of the limited warranty. In addition, Avaya’s standard warranty language as well as information regarding support for the Product, while under warranty, is available through the following web site: http://support.avaya.com.

License

USE OR INSTALLATION OF THE PRODUCT INDICATES THE END USER’S ACCEPTANCE OF THE GENERAL LICENSE TERMS AVAILABLE ON THE AVAYA WEB SITE AT: http://support.avaya.com/LicenseInfo. (“GENERAL LICENSE TERMS”). DO NOT USE THE PRODUCT IF YOU DO NOT WISH TO BE BOUND BY THE GENERAL LICENSE TERMS. IN ADDITION TO THE GENERAL LICENSE TERMS, THE FOLLOWING LICENSE TERMS AND RESTRICTIONS WILL APPLY TO THE PRODUCT.

Avaya grants End User a license within the scope of the license types described below. The applicable number of licenses and units of capacity for which the license is granted will be one (1), unless a different number of licenses or units of capacity is specified in the Documentation or other materials available to End User. “Designated Processor” means a single stand-alone computing device. “Server” means a Designated Processor that hosts a software application to be accessed by multiple users. “Software” means the computer programs in object code, originally licensed by Avaya and ultimately utilized by End User, whether as stand-alone products or pre-installed on Hardware. “Hardware” means the standard hardware products, originally sold by Avaya and ultimately utilized by End User.
Designated System(s) License (DS). End User may install and use each copy of the Software only on a number of Designated Processors up to the number indicated in the order. Avaya may require the Designated Processor(s) to be identified in the order by type, serial number, feature key, location or other specific designation, or to be provided by End User to Avaya through electronic means established by Avaya specifically for this purpose.

Concurrent User License (CU). End User may install and use the Software on multiple Designated Processors or one or more Servers, so long as only the licensed number of Units are accessing and using the Software at any given time. A “Unit” means the unit on which Avaya, at its sole discretion, bases the pricing of its licenses and can be, without limitation, an agent, port or user, an e-mail or voice mail account in the name of a person or corporate function (e.g., webmaster or helpdesk), or a directory entry in the administrative database utilized by the Product that permits one user to interface with the Software. Units may be linked to a specific, identified Server.

Shrinkwrap License (SR). With respect to Software that contains elements provided by third party suppliers, End User may install and use the Software in accordance with the terms and conditions of the “shrinkwrap” or “clickwrap” license accompanying the Software (“Shrinkwrap License”). The text of the Shrinkwrap License will be available from Avaya upon End User’s request (see “Copyright” below for more information).

**Copyright**

Except where expressly stated otherwise, the Product is protected by copyright and other laws respecting proprietary rights. Unauthorized reproduction, transfer, and or use can be a criminal, as well as a civil, offense under the applicable law. Certain Software programs or portions thereof included in the Product may contain software distributed under third party agreements (“Third Party Components”), which may contain terms that expand or limit rights to use certain portions of the Product (“Third Party Terms”). Information identifying the copyright holders of the Third Party Components and the Third Party Terms that apply to them is available on Avaya’s web site at http://support.avaya.com/ThirdPartyLicense/.

The disclaimers of warranties and limitations of liability set forth in the Third Party Terms do not affect any express warranty or limitation of liability that may be provided to you by Avaya pursuant to the license terms covering the Product contained in a separate written agreement between you and Avaya. To the extent there is a conflict between the General License Terms or your customer sales agreement and any Third Party Terms, the Third Party Terms shall prevail solely for such Third Party Components.

**Security and Virus Disclaimer**

End User's decision to acquire products from third parties is End User's sole responsibility, even if Avaya helps End User identify, evaluate or select them. Avaya is not responsible for, and will not be liable for, the quality or performance of such third party products or their suppliers.

ALL INFORMATION IS BELIEVED TO BE CORRECT AT THE TIME OF PUBLICATION AND IS PROVIDED "AS IS". AVAYA DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND FURTHERMORE, AVAYA MAKES NO REPRESENTATIONS OR WARRANTIES THAT THE STEPS RECOMMENDED WILL ELIMINATE SECURITY OR VIRUS THREATS TO END USER’S SYSTEMS. IN NO EVENT SHALL AVAYA BE LIABLE FOR ANY DAMAGES WHATSOEVER ARISING OUT OF OR IN CONNECTION WITH THE INFORMATION OR RECOMMENDED ACTIONS PROVIDED HEREIN, INCLUDING DIRECT, INDIRECT, CONSEQUENTIAL DAMAGES, LOSS OF BUSINESS PROFITS OR SPECIAL DAMAGES, EVEN IF AVAYA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
Avaya does not warrant that this Product is immune from or will prevent unauthorized use of telecommunication services or facilities accessed through or connected to it. Avaya is not responsible for any damages or charges that result from either unauthorized uses or from incorrect installations of the security patches that are made available from time to time. Suspected security vulnerabilities with Avaya products should be reported to Avaya by sending mail to securityalerts@avaya.com.

**Trademarks**

All trademarks identified by ® and TM are registered trademarks or trademarks of Avaya Inc. All other trademarks are the property of their respective owners.

©2006 Avaya Inc. All rights reserved. Last modified January 2006

**General Contact Information**

<table>
<thead>
<tr>
<th>For</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya’s Home Page</td>
<td><a href="http://www.avaya.com">www.avaya.com</a></td>
</tr>
</tbody>
</table>
| Avaya products | [www.avaya.com](http://www.avaya.com)  
Then click Solutions & Products. |
| Online product catalog | [www.avayadirect.com](http://www.avayadirect.com) |
| International Alliance of Avaya Users | [www.inaaau.org](http://www.inaaau.org) |
### Contacting us for documentation

<table>
<thead>
<tr>
<th>To</th>
<th>Use this resource</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>View documentation online</td>
<td>Recent documents</td>
<td><strong><a href="http://www.avaya.com">www.avaya.com</a></strong>&lt;br&gt;Then click Support.&lt;br&gt;Then click Product Documentation.</td>
</tr>
<tr>
<td>Order documentation by mail</td>
<td>Globalware Solutions</td>
<td>Globalware Solutions&lt;br&gt;200 Ward Hill Avenue&lt;br&gt;Haverhill, MA 01835 USA&lt;br&gt;USA</td>
</tr>
<tr>
<td>Order documentation by phone or fax</td>
<td>Globalware Solutions</td>
<td>1 800 457-1235 (phone)&lt;br&gt;1 800 457-1764 (fax)&lt;br&gt;&lt;br&gt; If you are calling from somewhere that can not access US 1-800 numbers, then call:&lt;br&gt;&lt;br&gt; +1 410 568 3680 (phone)&lt;br&gt;+1 410 891 0207 (fax)</td>
</tr>
</tbody>
</table>

### Contacting us about training

#### For customers located in the US

<table>
<thead>
<tr>
<th>To</th>
<th>Use this resource</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ask general training questions</td>
<td>Avaya University</td>
<td>1 800 288 5327</td>
</tr>
<tr>
<td>Search an online catalog of classes, videotapes, and computer-based training</td>
<td>Avaya training web site&lt;br&gt;www.avaya.com&lt;br&gt;Then click Training.</td>
<td></td>
</tr>
<tr>
<td>Register for classes</td>
<td>Avaya University Registration Center</td>
<td>1 800 255 8988</td>
</tr>
<tr>
<td>Order videotapes and computer-based training</td>
<td>Avaya Direct</td>
<td><a href="http://www.avaya.com/direct">www.avaya.com/direct</a></td>
</tr>
</tbody>
</table>

#### For customers located outside the US:

Contact your local distributor or Avaya representative.
## Technical Support

Before you call, [prepare the information](#) that the helpline needs.

### For customers located in the US:

<table>
<thead>
<tr>
<th>For help with</th>
<th>Contact this resource</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSA</td>
<td>Avaya’s National Customer Care Center</td>
<td>1 800 242 2121</td>
</tr>
<tr>
<td>Avaya Communication Manager software</td>
<td>Avaya’s Communication Manager Helpline</td>
<td>1 800 225 7585</td>
</tr>
<tr>
<td>features and administration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avaya Communication Manager software</td>
<td>Avaya’s National Customer Care Center</td>
<td>1 800 242 2121</td>
</tr>
<tr>
<td>maintenance and repair</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voice mail systems</td>
<td>Avaya National Customer Care Center</td>
<td>1 800 242 2121</td>
</tr>
<tr>
<td>Toll fraud</td>
<td>Avaya’s National Customer Care Center (Toll</td>
<td>1 800 643 2353</td>
</tr>
<tr>
<td></td>
<td>Fraud Helpline)</td>
<td></td>
</tr>
<tr>
<td>web-based technical support</td>
<td>Avaya’s Customer Support <a href="http://www.avaya.com/support">http://www.avaya.com/support</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>web site</td>
<td></td>
</tr>
</tbody>
</table>

### For customers located outside the US

Contact your local distributor or Avaya representative.
Before you call

Before you call, please have the following information available:

- your name and number (in case we need to call you back)
- your installation location (IL) number
- your company’s main phone number
- the type of your voice system
- the number of trunks on your system
- the number of stations on your system

Remember, if the problem is with equipment or service outside of your own equipment, you need to call your vendor or service provider. If you determine that the problem is with your own equipment, such as on your own stations, voice system, or trunks, give Avaya a call.

Be ready to talk about:

- the problem you want to solve
- a log of the steps you took and the information you gathered while performing your diagnosis of the problem
- if the problem is with a new component or feature
- if something that used to work now does not work
- any numbers involved with the problem (for example, extensions or phone numbers, trunk group numbers, phone types, or report types)
- the contents of any recorded messages received
- error messages from the voice system
- type of ringback tones received on phones
- the names and numbers of your vendors
- any other pertinent information
## Giving us your feedback

<table>
<thead>
<tr>
<th>To</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ask questions not answered in the help by phone</td>
<td>Technical Support</td>
</tr>
<tr>
<td>Offer comments on the online help by email</td>
<td>DO NOT SEND PRODUCT OR TECHNICAL QUESTIONS TO THIS EMAIL ADDRESS:</td>
</tr>
<tr>
<td></td>
<td><a href="mailto:document@avaya.com">document@avaya.com</a> Subject line: MSA Help Topic &quot;&lt;Name of topic&gt;&quot; feedback.</td>
</tr>
<tr>
<td>by fax</td>
<td>+ 1 732 852 2469 Attention: MSA Documentation Team</td>
</tr>
<tr>
<td>by mail</td>
<td>MSA Documentation Team Room 3C-313 307 Middletown Lincroft Road Lincroft, NJ 07738-1526 USA</td>
</tr>
<tr>
<td>Share information with other Avaya product users over the web</td>
<td><a href="http://www.inaau.org">www.inaau.org</a></td>
</tr>
</tbody>
</table>
Index

A

ABIT .............................................................................40
accessing
voice systems using cut-through..................8
active jobs
canceling ..............................................................58
active jobs ..............................................................58
adding
stations ..................................................................42
translations .............................................................42
UDP Groups ..........................................................12
applying
templates ............................................................22
applying .................................................................22
assignments

group ......................................................................24
assignments ..........................................................24
AUDIX messaging reports ..........................72, 74
Avaya
National Customer Care Center ...............83
Toll Fraud Helpline .................................................83
training .................................................................82
Avaya .................................................................83

B

Browser Pane ...........................................................18
Bulk Import Tool .........................................................40
Bulk Import Wizard .........................................44, 46
buttons
phone feature buttons
changing ................................................................30
buttons ..................................................................30

C

canceling
active jobs ..............................................................58
schedule jobs ..........................................................58
canceling ..............................................................58
changes
scheduling .............................................................57
changing
feature buttons ......................................................30
passwords ...............................................................68
priority of a job .......................................................57
server information ...............................................59
set types ...................................................................29
translations .............................................................49
UDP group .............................................................68
user information ...................................................62
changing ..................................................................29
changing ..................................................................30
changing ..................................................................57
changing ..................................................................59
changing ..................................................................62
changing ..................................................................68
changing ..................................................................68
Changind a custom privileges profile ........65
Changing system passwords .....................66
Communication Manager
support .................................................................83
configuration
wizard .................................................................9
configuring
MultiSite Administration .............................9
copying
templates ..............................................................22
copying .................................................................22
COR
assignments ..........................................................24
COR .................................................................24
COS .................................................................24
coverage
path assignments .................................................24
creating
object templates ..................................................43
report templates .....................................................55
stations .................................................................24
creating .................................................................24
creating .................................................................26
custom privileges ..............................................11, 63
cut-through ..........................................................8

D
data
polling manually ...................................................56
data .................................................................56
definitions
destination ............................................................76
display report .........................................................78
list report ...............................................................78
definitions ............................................................78
J
jobs
  canceling active jobs..............................58
  canceling scheduled jobs..........................58
  changing the priority of..........................57
  scheduling..........................................57
jobs....................................................57
jobs....................................................58
L
layout...................................................55
list reports defined...............................78
log
  files
    understanding....................................14
log......................................................14
logging in..........................................14
M
maintenance.........................................85
manual
  polling.............................................56
manual................................................56
margins...............................................55
memberships........................................31
menus
  MSA Manager........................................71
  Report Manager....................................76
  Station Manager...................................74
  System Manager...................................72
menus..................................................71
menus..................................................71
menus..................................................72
menus..................................................74
menus..................................................76
messaging systems..................................12
modifying
  feature buttons..................................30
  UDP group...........................................68
modifying.............................................30
modifying.............................................68
moves
  scheduling..........................................57
moving
  stations............................................35, 36
  stations among groups.........................31
  stations by swapping............................34
moving.................................................31
moving...............................................34
moving...............................................35
moving...............................................36
MSA Manager
  understanding.....................................18
MSA server..........................................9
MultiLingual Name Wizard........................37, 52
MultiSite Administration
  assigning users....................................10, 60
  setting up.........................................9
MultiSite Administration........................10
MultiSite Administration........................60
MultiSite Administration features...............1
N
native name..........................................37, 52
O
options
  for removing translations........................51
  printing.............................................55
orientation.........................................55
P
paper source........................................55
password
  changing............................................68
passwords............................................66
permissions
  viewing.............................................61
permissions...........................................61
phones
  changing set types...............................29
Pickup Group
  assignments.......................................24
Pickup Group.........................................24
polling...............................................56
printing
  options.............................................55
priority
  of jobs
    changing..........................................57
priority.............................................57
privileges..........................................11, 63
Public Unknown Numbering table ..........46
publications .......................................82

Q
queue
defined .........................................77
starting ............................................13

R
removing
active jobs ....................................58
destinations ....................................69
scheduled jobs ................................58
stations ..........................................58
translations ......................................51
translations (options for) .................51
UDP group .......................................68
user that is logged in .......................66
removing ...........................................36
removing ...........................................51
removing ...........................................58
removing ...........................................58
removing ...........................................66
removing ...........................................68
removing ...........................................69
Removing a custom privileges profile ...65
Report Manager ................................20
reports
creating templates for .......................55
display report defined .......................78
list report defined .............................78
reports ..............................................20

S
schedule
deleting jobs ..................................58
scheduling
jobs ..............................................57
scheduling .......................................57
screens
MSA Manager ....................................18
screens ............................................16, 18
screens ............................................18
screens ............................................19
screens ............................................19
screens ............................................20
screens ............................................20
screens ............................................21
server
viewing information ........................59
server ..............................................59
set type
changing ..........................................29
set type ............................................29
setting up
MultiSite Administration .................9
station
templates
creating ..........................................26
templates applying ..........................22
station .............................................26
station data .....................................27
station extensions ............................33
Station Manager
understanding ................................20
Station Manager ................................20
stations
adding ............................................42
creating new .................................24
duplicating .....................................49
moving ............................................35, 36
moving among groups ......................31
removing ..........................................36
swapping ...........................................34
stations .............................................24
stations .............................................31
stations .............................................33
stations .............................................34
stations .............................................35
stations .............................................36
stations .............................................36
stations .............................................42
support ............................................81, 83, 85
swapping stations .............................34
System Manager
understanding ................................19
System Manager ................................19
system passwords .............................66
tabs ......................................................18, 19 
Task tab ....................................................19 
Task tab ....................................................19 
Task tab ....................................................20 
technical support ........................................81, 83 
templates ....................................................22 
applying ....................................................22 
copying ....................................................22 
creating .....................................................26, 55 
deleting .....................................................23 
understanding ............................................15 
toolbar .......................................................17 
training .......................................................82 
translations ..................................................42 
adding .......................................................42 
changing .....................................................49 
duplicating ..................................................49 
importing ....................................................43 
removing .....................................................51 
removing (options for) ..................................51 
scheduling ..................................................57 
translations ..................................................43 
translations ..................................................51 
translations ..................................................57 
Tree tab .....................................................21 
troubleshooting ..........................................84 

U
UDP Group ...................................................12 
adding a ......................................................12 
removing .....................................................68 
updating .....................................................68 
UDP Group ...................................................68 
UDP Group ...................................................68 
UDP Group ...................................................68 
Unassigning users from Systems ..........62 
understanding .............................................62 
Browser Pane .............................................18 
log files .....................................................14 
MSA Manager tab ......................................18 
queue .........................................................77 
Report Manager ........................................20 
Station Manager ........................................20 
System Manager ........................................19 
Task tab .....................................................19 

templates .....................................................15 
Tree tab .....................................................21 
workspace ..................................................16 
understanding .............................................14 
understanding .............................................15 
understanding .............................................16 
understanding .............................................18 
understanding .............................................18 
understanding .............................................19 
understanding .............................................20 
understanding .............................................20 
Unicode .....................................................37, 52 
updating .....................................................30 
feature buttons ..........................................30 
set types ....................................................29 
UDP group ...................................................68 
updating .....................................................29 
updating .....................................................30 
updating .....................................................68 
users ..........................................................10 
assigning to systems ...................................10, 60 
changing information ...................................62 
disconnecting .............................................66 
removing when logged in ..............................66 
viewing information about .........................61 
users ..........................................................10 
users ..........................................................11 
users ..........................................................60 
users ..........................................................62 
users ..........................................................63 
Using the Avaya Bulk Import Tool ABIT ... 40 

V
viewing ..........................................................59 
server information ........................................59 
user information ..........................................61 
viewing .........................................................59 
viewing .........................................................61 
Viewing a custom privileges profile ...........64 
voice systems ..............................................13 
initializing ...................................................13 
voice systems ..............................................13 

W
wizards .........................................................9 
workspace ....................................................16